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	Please NOTE the following Websites:

	GAEOP Website

	www.geocities.com/gaeoponline/index.htm

	NAEOP Website

	www.naeop.org


	 Inside This Issue

	1
	GAEOP Nominations Information & Form 

	2
	GAEOP Spring Installation Seminar Registration Form

	3
	Announcements & GAEOP Fall Conference Information  
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This year GAECP is doing things a little different. We want you to bring your family & friends to participate in the

installtion of our 2007 officers. It will be informal & fun. Trying to make It more assessable for everyone to
come & see what GAEOP is all about.

(NOTE: we need a head count by June 2, 2007. Thank you.)

The Georgla Assoclation of Educational Office Professionals is pleased to host the GAEOP Spring Installation
Seminar scheduled for: June 09, 2007, at one of Georgia's State Parks & Historic Sites:

Panola Mountain State Conservation Park
Panola Mountain Conference Room
2600 Ga. Hwy. 155, SW
Stockbridge, GA 30281
Park: (770)-389-7801
Park Holrs: 9 AM - SPM
ht astateparks.org/info fpanolam

Arrive at the conference room anytime after 10:30 AM. The luncheon will begin at 11:30 AM with Installation of
New Officers and Awards Ceremany to fallow.

*PLEASE send form & check for reservations by June 02*

an informal luncheon, "picric” style atmosphere for all to eroy,
will be provided with lunch trays from “Chick-Fil-A" along with

homermade items by GAEOP mermbers. Lots. of aoodies.for.ll.
Registration Fee (Includes Lunch)

$15.00 /GAEOP Member and. Non-Member
$5.00/Child Family Member (s)

There is a $ 3,00 Parking Fee for State Park/car

HRIHIIIIIIKAIIARIRARAARK REGISTRATION FORMIRHI AR AAAAAAAAAAAAAAAK

Name: E-mait:
Address:
ECS C3 State Zb

County: Telephone: (H). wy: Fax:
School System:
O administration Cletementary [ secondary Cltigher E4 [vocationa!
1 will need ticket(s) for the Instafiation Seminar: Regisiration @ $15.00= _______ (Enclosed)
1 will need ticket(s) for the nstafiation Seminar: Regisiration @ ¢ 5.00 _ (Enclosed)
Mail revised Reqistration
Eorm to: [Barbara Pisano, CEOE

1061 Alden Drive

Augusta, GA 30906 Make Checks Payable to: GAEOP
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	Barbara Pisano, CEOE
2006-2007 GAEOP Co-President Elect

1061 Alden Drive
Augusta, GA 30906

	
	

	
	

	ADDRESS CORRECTION REQUESTED
	


Tune Up Your Professional Skills








Qualifications for GAEOP Officers Elections:


(Determined by GAEOP By-laws)





1.  All elected officers must be an active member of GAEOP.





2.  President-elect nominees must be an active member of GAEOP; have served at least (2) years on the executive board; and must be a member of NAEOP.





3.  Vice-president nominees must be an active member of GAEOP; and served at least (1) year on the executive board.





4.  Secretary nominees must be an active member of GAEOP.





5.  Treasurer nominees must be an active member of GAEOP.  (The treasurer may serve (2) consecutive terms in office.)





Article IV.  Officers & Executive Board





Section 1.  The elected officers of the association shall be: President, President-Elect, Vice-President, Secretary, and Treasurer.





Section 2.  The President-Elect shall automatically become President for a term of one year at the close of her term of office or if the office of President is vacated.





Section 3.  To qualify for nomination to an elective office, a nominee shall be an active member of GAEOP.





Section 4.  To be eligible for nomination to the office of President-Elect, the nominee shall also have served at least TWO (2) years on the executive board and must be a member of NAEOP.





Section 5.  To be eligible for nomination to the office of Vice-President, the nominee shall also have served at least ONE (1) year on the executive board.





Section 6.  Should it become necessary for a candidate to qualify for direct nomination to the office of President, the candidate shall meet the same qualifications as that of the President-Elect.





Section 7.  Officers shall begin their term of office on the July 1 following their election and shall serve for ONE year or until their successors are elected.





Section 8.  No officer, with the exception of treasurer, shall serve consecutive terms.  The treasurer may serve two consecutive terms in office.





Section 9.  The executive board shall consist of the: PRESIDENT, PRESIDENT-ELECT, VICE-PRESIDENT, SECRETARY, TREASURER, IMMEDIATE PAST-PRESIDENT, AREA CHAIRMEN, AND COMMITTEE CHAIRMEN.  


GAEOP Spring Conference  





This state park was created to protect a 100-acre granite monadnock (mountain) often compared to Stone Mountain near Atlanta. Minimally developed, Panola Mountain shelters rare plants and animals of the Piedmont region. It has 1 conference room & that is where our Spring Conference is to be held. 





Where is Panola Mountain State Park?





























GAEOP Fall Conference  





This year the date of the Fall Conference will be, October 25-27, 2007. The conference will be in Rome, Georgia at the Holiday Inn Skytop Conference Center-Rome.  Situated atop Rome's rolling hills, this 200 room hotel offers banquet and meeting space, a full service restaurant, a lounge with nightly entertainment and indoor/outdoor heated pool,  voice mail and data ports, cable, local calls, exercise, lounge, smoking, non-smoking, handicapped rooms, Jacuzzi and fitness room. They are a member of the Hospitality Association of Rome and Floyd County.  (East Rome US 411 Phone: 706-295-1100).





You can get information about the motel by going to: � HYPERLINK "http://www.ichotelsgroup.com/h/d/hi/1/en/hotel/rmgea?_requestid=36184" ��http://www.ichotelsgroup.com/h/d/hi/1/en/hotel/rmgea?_requestid=36184�





The weekend of the conference is: Chiaha Festival, a craft festival of individual artists & craftsmen, handmade furniture, pottery, jewelry, paintings, entertainment, and food in a beautiful park along the banks of the Oostanaula River.





You can find out information about Rome on-line at: � HYPERLINK "http://www.romegeorgia.org/index.asp" ��http://www.romegeorgia.org/index.asp�. 





Berry College, is a must see at Rome,Georgia. � HYPERLINK "http://www.berry.edu/" ��http://www.berry.edu/� 	  


   


Where is Rome?





From Atlanta take I 75 North to Exit 290 at Cartersville, GA Hwy 20 to US Hwy 411 South (Four Lanes) This gets confusing if you do not watch (Rome is north of Cartersville, but you take Hwy 411 South to Rome from Cartersville).  





Exit 306, Adairsville travel west on Hwy 140 to Hwy 53, then west or left on to Hwy 53 to Rome.





From Chattanooga, TN take I 75 South to Exit 312 at Calhoun GA US Hwy 53 West (Four Lane).





From Birmingham, AL take I 59 North to I 759 at Gadsden, AL to US Hwy 411 North.




















2006-2007 GAEOP Officers


President: Debra Walker,  Clarke County Schools�         (W) 706-546-7721 x18270     � HYPERLINK "mailto:walkerd@clarke.k12.ga.us" ��walkerd@clarke.k12.ga.us�


Co-Presidents Elect: Barbara Pisano, CEOE, GCEOP�                  Medical College of GA       (W) 706-721-8972�                 � HYPERLINK "mailto:btpisano@netzero.com" ��btpisano@netzero.com�


                Paulette Woodard, GCEOP      Polk County Schools                �                 (W) 770-684-8718        � HYPERLINK "mailto:pwoodard@polk.k12.ga.us" ��pwoodard@polk.k12.ga.us�


Vice President:  Ann-Marie Lee, GCEOP � HYPERLINK "mailto:amlee@mcsdga.net" ��amlee@mcsdga.net�                	Muscogee County Schools     (W) 706-748-2109


Secretary: Jan Knowles, GCEOP,  Muscogee County Schools�              (W) 706-748-2155     � HYPERLINK "mailto:jknowles@mcsdga.net" ��jknowles@mcsdga.net�


Treasurer:    Celia Evans       Muscogee County Schools      �             (W) 706-748-2208         � HYPERLINK "mailto:celiaevans@knology.net" ��celiaevans@knology.net�


Immediate Past President: Elizabeth Harris, CEOE, GCEOP�                 Georgia Perimeter College      (W) 770-274-5050�                  � HYPERLINK "mailto:aerial@gpc.edu" ��aerial@gpc.edu�


Your By-line


Your Company Name


This document was created using linked text boxes, which allow articles to flow continuously across pages. For example, this article continues on page two, while the one to the right continues on page three. When you add lines of words to a text box, the words in the following text box flows forward. When you delete lines of words from a text box, the words in the next text box moves backward. You can link several text boxes in an article, and you can have multiple articles in a document. The links do not have to occur in a forward direction.


Inserting Linked Text Boxes


To insert linked text boxes in a document, click Text Box on the Insert menu. Click and drag in your document where you want to insert the first text box, and insert additional text boxes where you want the text to flow.


To select the first text box, move the pointer over the border of the text box until the pointer becomes a four-headed arrow and then click the border. Click the right mouse button, click Create Text Box Link and then click in the text box where you want the text to flow. Repeat these steps to create links to additional text boxes.


In the first text box, type text that you want. As the text box fills, the text will flow into the other text boxes that you’ve linked. To let the reader know that an article will continue on another page, insert a small text box under the text box, choose the Jump To style, and then type the words “Continued on Page.” Click Cross-reference on the Insert menu. Choose Heading from the Reference type drop-down list, and Page Number from the Insert Reference To. Select the name of the follow-up heading from the For Which Heading list box and then click Insert.


Formatting Text Boxes


You can change the look of linked text boxes by using color, shading, borders, and other formatting. Select the text box you want to format and then double click its border to open the Format Text Box dialog box. If you want to change the color or borders on a text box, choose the Colors and Lines tab. To change the size, scale, or rotation, click the Size tab. To change the position of the text box on the page, click the Position Tab.  If you have other text surrounding the text box, and want to change the way the text wraps around it, click the Wrapping tab. If you want to format all the text boxes in an article, you must format them individually - the formatting on one text box will not apply to the others in the sequence. 


Using Linked Text for Parallel Articles


You can use linked text boxes to flow text in parallel  “columns” from page to page. This method gives different results than using the Column command on the Format menu, which causes text in column 1 to flow or “snake” to column 2 on the same page. By using linked text boxes, you can instead have text from column 1 flow to column 1 on the next page. The text beside it in column 2 can flow to column 2 on the next page, parallel to column 1. This technique is useful if you need to group two similar articles, for instance, an article translated in English on the left and the same article translated in French on the right. 


To flow text in parallel, display paragraph marks in your document. Click at the top of the page where you want the side-by-side columns to start, and press Enter twice. Click in the first paragraph mark on the page. On the Insert menu, click Text Box and drag on the page where you want the first column. Click Text Box again and then click and drag where you want the second column. Click in the last paragraph mark on the page, and press Ctrl + Enter to create a page break.


Repeat the process for each page that will contain side-by-side columns in your document and then return to the first text box you created. Click the text box on the left once to select it. Click your right mouse button and then click Create Text Box Link. The pointer becomes a pitcher. Click the text box on the left side of the second page to create a link. Create links for all text boxes within the same article on the left side of the document. Repeat the process for every text box in the right chain or article.


Pressing Enter twice at the top of each page will create an extra empty paragraph. This blank paragraph is useful if you want to insert text or graphics outside of the text boxes. You can delete the extra blank paragraph if you don't need it.


Copying linked text boxes


You can copy an article or a chain of text boxes that are linked together, to another document or to another location in the same document. To copy linked text boxes and the text they contain, you must copy all the linked text boxes in an article. Select the first text box in an article. Hold down Shift, and click each additional text boxes you want to copy. On the Edit menu, click Copy. Click where you want to copy the text boxes and then click Paste.


To copy some of the text from  an article, select the text you want to copy from the article and then copy it. Do not select the text box. You can paste text you’ve copied directly into your document, into another location within the same article, or into another article.(





MEMBER ANNOUNCEMENTS: 


March 19, 2007:  Phyllis Barnett lost her father, Roy Martin.  If you’d like to send her a card her address is: 3430 Blacks Creek Church Rd, Commerce, GA 30530.  Our condolences go out to her & her family.  


April 12, 2007:  Maxine Carter, Chaplain, lost all of her earthly belongings in a fire early morning. I do not have an immediate contact number for her but for those wanting to support her in some way (monetary or other) can contact her immediate supervisor Barbara Orbrentz at � HYPERLINK "http://webmailb.netzero.net/webmail/new/8?folder=Inbox&msgNum=0000D9G0:00167cFU00001PEz&block=1&msgNature=email&msgStatus=all&count=1177293405&content=central" \l "#" �bobrentz@gpc.edu� or phone Barbara at 678-891-2685. Your kindness and support would be appreciated during this difficult period.      Phyllis Jones


April 20, 2007:  Paulette Woodard’s husband, Joe, fell off their porch. Here is a message from Paulette to members:  


“My husband fell Friday, 4/20 & broke his arm & when they admitted him to the hospital we found out he has a heart problem.  Surgery for his arm is Monday or Tuesday.  But, God is good, at least we found about his heart problem & they can fix that. Plus it wasn’t his writing arm & though he blacked out it could have happened while he was driving rather than falling off the porch at home.  Sometimes you just have to hunt for the positive to be able to make it through these valleys here on earth.”     Paulette


April 22, 2007: Ann Patch, one of the founders of GAEOP, lost her husband & soul mate, Roy Patch, at 2:30 PM. He had been ill for several weeks. Our condolences go out to her & her family. 





 �





April 14, 2007:  Debbie Walker, GAEOP 2006-07 President, was “Married.”  Congratulations to her & her new husband. Best wishes from GAEOP.








 


	

















Located 18 miles southeast of Atlanta on GA. Hwy. 155 via 1-20 exit #68 


 


I285 to Hwy 155 Flat Shoals Rd. Go South till dead end, turn right & stay on Hwy 155. Panola State Park is on the right
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